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RZ/T2M Group, RZ/T2L Group, RZ/N2L Group 
CN032 AC Servo Solution Startup Guide (for Motion Control Utility) 
Introduction 
 

This startup guide is a quick start guide for CN032 AC Servo Solution Kit by using “Motion Control Utility 
Tool”. 
 
<<Caution when handling the solution board>> 
Don't touch the board while power is supplied because CN032 AC servo solution board contains high 
voltage circuits. 
 

Target Device 
 

RZ/T2M Group 

RZ/T2L Group 

RZ/N2L Group 

 

When applying the sample program covered in this startup guide to another microcomputer, modify the 
program according to the specifications for the target microcomputer and conduct an extensive evaluation of 
the modified program. 

 

Related Document 
 

 CN032 AC Servo Solution Controller Board Manual (for RZ/T2M, RZ/N2L) 

 CN032 AC Servo Solution Controller Board Manual (for RZ/T2L) 

 CN032 AC Servo Solution Inverter Board Manual 

 CN032 AC Servo Solution Firmware Manual 

 CN032 AC Servo Solution Startup Guide (for EtherCAT) 

 CN032 AC Servo Solution Startup Guide (for Motion Utility Control) (this manual) 

 

 RZ/T2M Group User’s Manual: Hardware 

 RZ/T2L Group User’s Manual: Hardware 

 RZ/N2L Group User’s Manual: Hardware 
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1. Overview 
1.1 CN032 AC Servo Solution Overview 
This application note is implemented by using the Controller board equipped with Renesas Electronics 
RZ/T2M, RZ/T2L or RZ/N2L and the Inverter board for 220V AC servo motor. 

This solution includes software that runs on the Controller board, PC software, and circuit diagram. 
Therefore, initial evaluation and advance development of industrial motor equipment development using 
RZ/T2M, RZ/T2L or RZ/N2L can be easily done. 

 

1.2 Connection Configuration 
Figure 1-1 is shown the connection configuration. 

 

 
Figure 1-1 Connection Configuration 

 
 

CN032 Motion Control Utility 

Controller board 
(RZ/T2M, RZ/N2L or RZ/T2L) 

Inverter board 
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1.3 Connection Equipment 
Table 1-1 is shown the connection equipment list. 
 

Table 1-1 Connection Equipment List 
No. Item Model Spec. 
1 220V AC Servo motor BM0602A1PD-A  

ZhuHai KaiBang Motor Manufacturing Co. , Ltd.  
200W, 3000rpm 

2 Encoder TS5669N140 
Tamagawa Seiki Co. , Ltd. 

17/16Bit 

3 Communication with the PC UART to USB converter - 

4 ICE - I-jet from IAR Systems 
- J-Link EDU from Segger 

- 

 

1.3.1 220V AC Servo motor 

 
 

1.3.2 Absolute Encoder 

 

Cable Color Signal 
Red U 
Brown W 
Blue V 
Yellow/Green GND(PE) 

BM0602A1PD-A 

Connecter (motor side) Conversion cable for connecting 
to Inverter board 

TS5669N140 

Conversion cable for 
connecting to Inverter board 

Connecter (encoder side) 
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1.3.3 Communication with the PC 
1.3.3.1 RS232 to USB  
The RS232 to USB Converter is connected to the J5 connector on the controller board. 
Table 1-2 is shown the connection with controller board. 

 
Figure 1-2 Serial connect to host PC 

 

Table 1-2 Connection RS232 to USB Converter with Controller board 
 

 

 

 

 
1.3.3.2 RS485 to USB 
The RS485 to USB converter is connected the J6 or J8 of the controller board. 

 
Figure 1-3 Serial connect to host PC 

 

1.3.3.3 Selection for RS232 or RS485 
RS232 or RS485 can be selected by SW2-1 according to Table 1-3. 

Table 1-3 Communication selection 

 RS232 RS485(default) 

SW2-1 ON OFF 

 

 SW2 on the board 

RS232 to USB converter J5 Note 
TXD(Green) RXD(J5-1)  
RXD(White) TXD(J5-2)  
NC 3V3(J5-3) Connection is not needed 
GND(Black) GND(J5-4)  

RS232 to USB Converter 

J5 

RS485 to USB Converter 

J8 

J6 
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1.3.4 ICE 
ICE is connected to the Controller board (ARM JTAG connector (10 pins)).  
 

 
Figure 1-4 Hardware debugger connection 

  

J15 
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1.3.5 Power Supply 
Supply 100-250V AC power to Inverter board, and supply 5V from Inverter board to Controller board by 
cable. 
 
 
 

 
 

Figure 1-5 Inverter board for 220V Motor 
 
 

 
Figure 1-6 Controller board 

 
 
 
  

100-250V AC 

5V DC 

LB  LA L2  L1 
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2. Operating Environment 
This solution kit is for the environment below. 
From this chapter onwards, the procedure for operating the 220V AC servo motor control system with 220V 
AC power supply is described. 

 

Table 2-1 Operating Environment 

Item Description 
RZ/T2M edition RZ/T2L edition RZ/N2L edition 

MPU Series RZ/T2M  
Dual Arm Cortex®-R52 

RZ/T2L 
Single Arm Cortex®-R52 

RZ/N2L 
Single Arm Cortex®-R52 

Package R9A07G075M24:  
225-pin FBGA 

R9A07G074M08:  
196- pin FBGA 

R9A07G084M04:  
225-pin FBGA 

Operating frequency 800MHz 800MHz 400MHz 

Operating modes xSPI0 boot mode (x1 boot Serial flash) 

Operating voltage 3.3V/1.8V/1.1V 

Power source for Inverter 
board 

220V AC, 1.5A max. consumption 

Devices 
(Functions to be used on 
the board) 

Serial flash memory 
Manufacturer: Renesas 

Model: AT25SF128A-SHB-T 
Integrated development 
environment 
 
Refer to Appendix 7.2 on how to 
install. 

IAR Systems Embedded WorkbenchⓇ for Arm 9.32.2 

Renesas Electronics e2studio 2023-07 
Toolchain GNU ARM Embedded 9.3.1 (*1) 
Renesas Electronics FSPSC 2023-07 (*2) 

Flexible Support Package 
(FSP) 

RZT FSP v1.3.0 RZN FSP v1.3.0 

Emulator Manufactured by IAR Systems 
I-jet 

Manufactured by SEGGER 
J-Link EDU Ver.11.0 

PC Software Manufactured by Renesas 
CN032 Motion Control Utility 

(*1) For instructions on how to install the toolchain, refer to Chapter 7.2.2 Toolchain Install 

(*2) FSPSC (FSP Smart Configurator) is a code generation tool for IAR Embedded Workbench. 

 

The Table 2-2 Controller board and inverter board combination shows the combination of the controller board 
and inverter board. Operation is not guaranteed with any combination other than the following. 

Table 2-2 Controller board and inverter board combination 

No. Controller board Inverter board 

V1.1 V1.2 V2.1 

1 RZ/T2M(v1.1), RZ/N2L(v1.1) Available Available N/A 

2 RZ/T2M(v2.1), RZ/N2L(v2.1) N/A N/A Available 

3 RZ/T2L(v1.0) Available Available N/A 

4 RZ/T2L(v2.0) N/A N/A Available 
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The No.2 in Table 2-2 requires Software Package Ver.5.02(r12an0123xx0502-cn032-ac-servo-solution) or 
later, the No. 4 requires Software Package Ver.5.01(r12an0123xx0501-cn032-ac-servo-solution) or later. 

When operating No.1 in Table 2-2 on Software Package Ver.5.02(r12an0123xx0502-cn032-ac-servo-
solution) or later, change the mode of P03_5 to “Disable” in Pin Configurations. 

When operating No.3 in Table 2-2 on Software Package Ver.5.01(r12an0123xx0501-cn032-ac-servo-
solution) or later, change the mode of P15_1 to “Disable” in Pin Configurations. 

The procedure will be explained using the development environment e2studio of No.3 as an example. 

 

 
 

Then click “Generate Project Content” button. 
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3. Board Setting 
3.1 Switches 
3.1.1 Controller board 
Table 3-1 is shown the switches setting of the Controller board. 
 
 Table 3-1 Switches Setting of Controller board 

No SW Item Setting Description 
1 
 

SW1 
 (Boot mode)  

1 MD0 1=ON xSPI0 boot mode (x1 boot Serial flash) 
2 MD1 2=ON 
3 MD2 3=ON 
4 MDD 4=ON JTAG normal mode 
5 MDW 5=OFF  1 wait 
6 No use - - 

2 SW2 1 RS485/RS232 1=OFF 
 

OFF: RS485 mode 
ON: RS232 mode 

 
 
 

3.2 Jumpers 
3.2.1 Controller board 
Table 3-2 is shown the jumpers setting of the Controller board for RZ/T2M, RZ/T2L and RZ/N2L. 
Table 3-3 is shown the jumpers setting of the Controller board for RZ/T2L. 
 
Table 3-2 Jumpers Setting of Controller board for RZ/T2M, RZ/T2L and RZ/N2L 

No JP Item Setting Description 
1 J2 PWM signal of V- phase 1-2 short  Select MTU3 output signal 
2 J3 PWM signal of W+ phase 2-3 short Select MTU3 output signal 
 
Table 3-3 Jumpers Setting of Controller board for RZ/T2L 

No JP Item Setting Description 
1 J14 RXD1/ENCIFDI1 selection 1-2 short  Select RXD1 signal from encoder 
2 J15 TXD1/ENCIFDO1 selection 1-2 short Select TXD1 signal from encoder 
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4. CN032 AC Servo Solution Execution procedure 
4.1 Precaution before operation 

 

4.2 AC Servo Solution Starting 
① Connect 220V AC motor to the Inverter board 

 
Note: silk for U/W on the inverter board (v1.1 only) is wrong printed. 

② Connect power supply cable to the Inverter board 
LA and L1 of P4 are connected to AC 220V + (blue cable). 
LB and L2 of P4 are connected to AC 220V – (black cable). 

 
③ Connect between the Controller board and the Inverter board 

④ Connect the encoder to the Controller board 
The encoder is connected to the D-Sub15pin connector, and it is connected to the J13 connector of the 
Controller board.  

⑤ Connect the J6 or J8 of the Controller board to PC through RS485 to USB converter.  
    or 
Connect the J5 of the Controller board to PC through RS232 to USB converter. 

 
 

 

 Motor Inverter Board 

Connection W P4-6 

V P4-7 

U P4-8 

GND(PE) P4-12 

When using this kit, please kindly comply with the following 1 to 3: 
 

1. Use stable power supply with current 1[A] limit setting to inverter board. 
2. Do not use DC12-24[V] power supply jack to controller board. 

※The power of controller is supplied from the inverter board. 

3. Even after turning off, please do not touch the inverter board when high voltage 
LED(D27) is on which could be about 3 minutes or more.  

 
If motor malfunctions or makes noise during use, please turn off the power to the inverter board 
immediately. 
If this malfunction symptom continues, please contact our sales office or agency. 

P4 

U   V   W GND 

LA 
LB 
L1  
L2 
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After connecting steps 1 to 5 above, the boards will look like the figure below. 

 
⑥ xSPI0 boot mode setting 

Set SW1 of the Controller board to the following. 

 
⑦ Power supply to the Inverter board, and then the red lamp lights up. 

Additionally, the Controller board is supplied 5V DC power from Inverter board and then LED1 lights up. 

 
* : If the program is not stored in the serial Flash ROM, the program is written to the serial Flash ROM. Refer 
to "7.3 56Program Writing Procedure". 

 

  

② Power 
supply 

① 220V AC 
Motor 

④ Encoder 
③ Board connection 

⑤ Serial communication 

Power lamp of the Inverter board Power LED of the controller board 
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4.3 Motion Control Utility Execution 
4.3.1 Installation 
Copy the following ZIP file to any folder (*) and unzip the zip file. 

CN032_Motion_Utility_For220V.zip 

 

* The Motion Control Utility can be used in the Controller board equipped with RZ/T2M,RZ/T2L or RZ/N2L. 

* The folder path name to expand CN032_Motion_Utility_For220V.zip should be alphanumeric characters. 

* About ZIP file detail, refer to “7.1 Package Folder Structure”. 

 

4.3.2 Demonstration Mode 
4.3.2.1 Motor Parameter Setting 
The “default.mtr” is for BM0602A1PD-A motor. 
 
 
4.3.2.2 Starting the CN032 Motion Utility.exe 
■When RS-232 / RS-485 is connected 
Select the COM port number and “Demonstration”. Push the “OK” button. 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
■RS-422 is not supported 
 
■Display the connection error 
 
 
 
 
 
 
 
 
 
 
 
Double-check the CN032 AC Servo Solution connection (refer to “3 Board Setting”), restart the Motion Utility. 
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4.3.2.3 Demonstrations Mode 
In Demonstrations Mode, it is possible to check the operation of speed control/ torque control / position 
control. To display with PC/tablet, the scaling of various toolboxes is changed according to the screen size.  
The speed control/torque/position control screen is switched by tab. “Demo Mode” button is had at each 
control screen and is controlled automatically by pushing this button. 
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(1) Position Control Screen 
Figure 4-1 is shown the Position Control screen. 

 

 

 

 

 

 

 

 

 

 

 

Figure 4-1 Position Control Screen 
 

No. Item Description 
① Servo On/Off This toggle button is controlled the power supply on/off.  

・When this button is pressed while "Servo On" is displayed, the motor power is turned 
off. 
・When this button is pressed while "Servo Off" is displayed, the motor power is turned on 

② RUN/STOP This toggle button is started/stopped the position control. 
・When this button is pressed while "RUN" is displayed, the motor rotates to 
distance(target distance) and stops by applying a torque when reaching the target 
distance.  When stopping, this toggle button is displayed “STOP” -> “RUN”. 

・When this button is pressed while "STOP" is displayed, the motor stops emergency. 
When stopping, this toggle button is displayed “STOP” -> “RUN”. 

③ CW/CCW This toggle button is controlled the direction of motor rotation. 
・When this button is pressed while "CW" is displayed, the motor rotates forward 
(clockwise when viewed from the output shaft side).  
・ When this button is pressed while "CCW" is displayed, the motor rotates reverse  
(counter clockwise when viewed from the output shaft side). 

④ Distance Target distance is set. 0 to 2000 (1 step) can be set. 
This value cannot be changed while motor rotates. 

⑤ Distance Result The movement distance (result) is displayed at 100ms intervals. 
⑥ Demo Mode This toggle button is operated the Position Control automatically. 

When this button is pressed while "Demo Mode" is displayed, the following operations are 
performed. 
1. Start the Position Control toward the target position: 20000. 
2. After 10 seconds, restart toward the certain target distance: 0. 
3. Repeat the above No.1 and No.2. 
 
When this button is pressed again, the motor stops. While operating Demo Mode, other 
buttons (RUN / STOP button, etc.) cannot be used.  If other tab (Torque tab/Speed tab) is 
pressed while operating Demo Mode, Demo Mode is stopped emergency. 

⑦ Graph Waveform of current motor position value (Blue), Pos error (Green) and Id/Iq current value 
(Red/Orange) are displayed at 100ms intervals as default. 
The variables and scaling displayed in the graph can be changed. See “5 Variables” for 
variables. 

 

Note: When using UART to RS232 cable, if there are any noise in the waveform displayed in the graph, 
please use UAER to RS485 cable. 

① 

② ③ 

④ 

⑤ 

⑥ 

⑦ 
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Speed Control Screen 
Figure 4-2 is shown the Speed Control screen. 

 
Figure 4-2 Speed Control Screen 

 

No. Item Description 
①  Servo On/Off This toggle button is controlled the power supply on/off.  

・When this button is pressed while "Servo On" is displayed, the motor power is turned 
on. 
・When this button is pressed while "Servo Off" is displayed, the motor power is turned 
off. 

②  RUN/STOP This toggle button is started/stopped the speed control. 
・When this button is pressed while "RUN" is displayed, the motor rotates at speed[rpm] 
(target speed). When rotating, this toggle button is displayed “RUN” -> “STOP”. 

・When this button is pressed while "STOP" is displayed, the motor stops emergency. 
When stopping, this toggle button is displayed “STOP” -> “RUN”. 

③  CW/CCW This toggle button is controlled the direction of motor rotation. 
・When this button is pressed while "CW" is displayed, the motor rotates forward 
(clockwise when viewed from the output shaft side).  
・ When this button is pressed while "CCW" is displayed, the motor rotates reverse  
(counter clockwise when viewed from the output shaft side). 

④  Speed[rpm] Target speed is set. 0 to 2000 [rpm] (1 step) can be set. 
This value can be changed while motor rotates. 

⑤  Speed 
Result[rpm] 

The current speed (result) is displayed at 100ms intervals. 

⑥  Demo Mode This toggle button is operated the Speed Control automatically. 
When this button is pressed while "Demo Mode" is displayed, the following operations are 
performed. 
1. Start the Speed Control at the target speed: 500. 
2. After 5 seconds, restart at the certain target speed: 2000. 
3. Repeat the above No.1 and No.2. 
 
When this button is pressed again, the motor stops. While operating Demo Mode, other 
buttons (RUN / STOP button, etc.) cannot be used.  If other tab (Torque tab/Position tab) 
is pressed while operating Demo Mode, Demo Mode is stopped emergency. 

⑦  Graph Waveform of current motor position value (Blue), Pos error (Green) and Id/Iq current value 
(Red/Orange) are displayed at 100ms intervals as default. 
The variables and scaling displayed in the graph can be changed. See “5 Variables” for 
variables. 

 

 

  

② ③ 

④ 

⑤ 

⑥ 

⑦ 
① 
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(2) Torque Control Screen 
Figure 4-3 is shown the Torque Control screen. 

 
Figure 4-3 Torque Control Screen 

 

No. Item Description 
①  Servo On/Off This toggle button is controlled the power supply on/off.  

・When this button is pressed while "Servo On" is displayed, the motor power is turned 
on. 
・When this button is pressed while "Servo Off" is displayed, the motor power is turned 
off. 

②  RUN/STOP This toggle button is started/stopped the torque control. 
・When this button is pressed while "RUN" is displayed, the motor rotates at torque[mNm] 
(target torque). When rotating, this toggle button is displayed “RUN” -> “STOP”. 

・When this button is pressed while "STOP" is displayed, the motor stops emergency. 
When stopping, this toggle button is displayed “STOP” -> “RUN”. 

③  CW/CCW This toggle button is controlled the direction of motor rotation. 
・When this button is pressed while "CW" is displayed, the motor rotates forward 
(clockwise when viewed from the output shaft side).  
・ When this button is pressed while "CCW" is displayed, the motor rotates reverse  
(counter clockwise when viewed from the output shaft side). 

④  Torque[uNm] Target torque is set. 0 to 2000 [uNm] (1 step) can be set. 
This value can be changed while motor rotates. 

⑤  Speed[rpm] Target speed is set. 0 to 2000 [rpm] (1 step) can be set. 
This value can be changed while motor rotates. 

⑥  Torque 
Result[uNm] 

The current torque (result) is displayed at 100ms intervals. 

⑦  Demo Mode This toggle button is operated the Torque Control automatically. 
When this button is pressed while "Demo Mode" is displayed, torque control is started at 
the certain torque. 
 
When this button is pressed again, the motor stops. While operating Demo Mode, other 
buttons (RUN / STOP button, etc.) cannot be used.  If other tab (Position tab/Speed tab) is 
pressed while operating Demo Mode, Demo Mode is stopped emergency. 

⑧  Graph Waveform of current motor position value (Blue), Pos error (Green) and Id/Iq current value 
(Red/Orange) are displayed at 100ms intervals as default. 
The variables and scaling displayed in the graph can be changed. See “5 Variables” for 
variables. 

 

 

① 

② 
③ 

④ 

⑤ 

⑥ 

⑦ 

⑧ 
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(3) Setting Screen 
Figure 4-4 is shown the setting screen. Contents of Position tab/Speed tab/Torque tab can be configured. 

 
Figure 4-4 Setting Screen 

■Graph 

No. Item Description 
1 Channel1~Channel4 The show/hide of Channel1 to Channel4 graphs is set. And the graph display is valid 

when the check box is checked. 
2 Scale Scale is set in 0.125 units. And primary axis (left side) / secondary axis (right side) of 

Y axis is set with “Left” / “Right”. 
3 Data The displayed data (variable) is set. Refer to “5 Variables”. 
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4.3.3 Tuner/Analyze Mode 
 
4.3.3.1 CN032 Motion Utility.exe Starting 
■When RS-232 is connected 
Select the COM port number and “Tuner/Analyzer”. Push the “OK” button. 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
■RS-422 is not supported 
 
■Display the connection error 
 
 
 
 
 
 
 
 
 
 
 
Double-check the CN032 AC Servo Solution connection (refer to “3 Board Setting”), restart the Motion Utility. 
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4.3.3.2 Position Control Execution 
This chapter shows an execution example of Position Control. About detail specification, refer to “4.4 
Tuner/Analyzer Mode Specification”. 

 

(1) Import of the Motor Parameters 
Select the [File]>[Import] of the menu and select the motor parameters in the same folder as CN032 Motion 
Utility.exe. 
  Motor: BM0602A1PD-A -> default.mtr 
 
 
(2) Power ON 
Push the “Power ON” button. 
 
 
 
 
 
 
 
 
(3) Phasing Operation 
Select the “Setup” tab, push the “Phase” button. 
 
 
 
 
 
 
 
(4) Servo ON 
Push the “Servo On” button. 
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(5) Position Control 
Push the “Cycle Move P1-P2” button. The position of the motor is repeated 0 or 10000. 
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4.4 Tuner/Analyzer Mode Specification 
Figure 4-5 is shown the main screen of Tuner/Analyzer mode. 

Tuner/Analyzer mode is for the configuration of motor parameter, tuning and diagnostic of the Solution. This 
mode has a GUI (graphical user interface) that displays various parameters and commands and has a 
terminal emulator that can read and write variables dynamically. In addition, a Motion Scope is displayed 
linear graphs of important controller variables. 

 

 
Figure 4-5 Main Screen 
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4.4.1 Menu 
4.4.1.1 File 

 
 

No. Item Description 
1 Import Motor parameters are imported. (Extension: *.mtr) 
2 Export Motor parameters are exported. (Extension: *.mtr) 
3 Save to Flash Motor parameters are written to the Flash ROM of the Controller board. (Address 

(:0xB0000~(ch1 of motor)) of Flash ROM that firmware of the solution is stored. ) 
 
* Execute when the power is turned off (motor stopped). 
* After writing the motor parameters, turn off the power of the solution board and restart. 

About motor parameters, refer to “6 Motor Parameters”. 

 

4.4.1.2 Connect/Disconnect 
■Connect 

The connection dialog offers entering connection string which describes the communication interface. The 
string format also defines the type of the communication protocol. 
 

 

 
・The RS-232/ RS485 connection is implied by specifying COM followed by a number such as COM5. The 
baud rate is fixed at 115,200 bps 

・The RS-422 connection is not supported. 

 

■Disconnect 

The communication is disconnected. If connecting again, “Connect” is selected. 
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4.4.1.3 View 

 
■Control Panel 

Part of the red frame is shown/ hidden. 

 
 

■Motion Scope 

Motion Scope screen is shown/ hidden. 
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■Terminal 

Part of the red frame is shown/ hidden. 

 
 

■Refresh 

Motor parameters of default (when shipping) are refreshed. 

 

4.4.1.4 Help 
■About 
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4.4.2 Main Screen 

 
No. Item Description 
1 Module ID Axis number of motor to be controlled is selected. 
2 Firmware Version Version of the solution firmware Is displayed. 
3 Status  Position The current coordinates of the motor are displayed. If pushing “0” button, 

the current coordinates is 0. 
4 Pos Error The actual coordinates and the distance to the target coordinates 

are displayed. 
5 Voltage DC bus voltage is displayed. 
6 Index The encoder counter value (Position value) (absolute value) is displayed. 

Every pressing the X button is updated. Incremental encoder is displayed 0. 
7 Id/Iq The current Id/Iq value are displayed.  
8 Torque The current torque value is displayed. 
9 Velocity The current speed[rpm] is displayed.  
10 Status/ 

Faults/Warnings 
 

The current status, faults and warnings are displayed. About detail, refer to 
“■Status/ Faults/ Warnings”. 

11 Commands Power On This toggle button is controlled the power supply on/off. 
12 Servo On This toggle button is controlled the servo on/off.  
13 STOP This button is stopped the rotation of the motor.  
14 Reset Error Flags This button is released the status of Faults/Warnings. By releasing the 

status of Faults/Warnings, "Servo On" button is valid. 
 

  

Control Panel 
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■Status/ Faults/ Warnings 

No. Indication Description 
1 “Moving”/ “Stopped” “Moving” or “Stopped” is displayed to 1st line. 

“Moving”:  The motor is rotating. 
“Stopped”: The motor is stopping. 

2 “Servo On”/ 
“Servo Off” 

“Servo On” or “Servo Off” is displayed to 2nd line. 
“Servo On”: The servo control is started. 
“Servo Off”: The servo control is stopped. 

3 "Power On” / "Power Off” "Power On” or "Power Off” is displayed to 3rd line. 
"Power On”: Power is turned ON. 
"Power Off”: Power is turned OFF. 

4 "Motor Phased”/ 
“Motor Not Phased” 

"Motor Phased” or “Motor Not Phased” is displayed to 4th line. 
"Motor Phased”: Motor phasing is completed. 
"Motor Not Phased”: Motor phasing is not completed. 

5 "Position Captured" The encoder count was acquired. 
6 “PVT Buffer Error” PVT buffer capacity were less than threshold. 
7 "Overcurrent” Over current was detected. 
8 "Amplifier Inhibit” Error by “4.4.3.5(5)Other”. 
9 "PVT Buffer Empty” PVT buffer empty were detected. 
10 “Overtemperature” Overheating was detected. 
11 "Amplifier Fault” Fault error from Current Sensor. 
12 "Position Error” The Max Position Error. 
13 "Wraparound Error” Position Counter Wraparound 
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4.4.3 Control Panel 
4.4.3.1 Setup Tab 

 
(1) Motor Configuration 

 
No. Item Description 
1 Motor Type Motor type is selected. 

・PMSM/Brushless DC (PMSM/ Brushless DC) 
2 Pole Pairs Count Motor pole pairs count is set. (1 to 16 can be selected.) 
3 Enc Counts/Revolution Encoder count for one revolution is set. 
4 Counts/Phase Electrical cycle (= the encoder counts per revolution divided by the number of 

pole pairs) is displayed. 
5 Position Inverted The position feedback can be inverted if needed. This option eliminates the need 

of changing the wiring of an incremental encoder if the direction motion does not 
correspond to the decoded position. 

6 Encoder Type Encoder Type is selected. 
0: Incremental 
3: FA-Coder 
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(2) Motor Commutation 

 
 

No. Item Description 
1 Commutation Mode Motor commutation mode is set. 

・”FOC Enc/DSM”: Sinusoidal vector control with encoder and Delta Sigma 
Modulator 

2 Windings Mapping Windings Mapping (U/V/W placement.) is selected. 
 

(3) Motor Phasing 

 
 

No. Item Description 
1 Phasing Mode Phasing mode is selected. About detail, refer to the following “■CN032 AC Servo 

Solution Firmware Manual”. 
 
1. Algorithmic 
an algorithm is executed upon power up of the controller. It energizes the 
windings creating known flux orientation that rotates the motor. After a small 
delay that allows the motor to settle the motor position is taken as a reference for 
the pole’s orientation. 
The advantage of using Algorithmic phasing is it does not need additional 
hardware and wiring, and its accuracy is pretty good. 
The disadvantage is that it executes small (half electrical cycle) but uncontrolled 
motion upon power up that may not be acceptable. 
 
2. Dithering 
algorithm moves the magnetic flux at various angles and identifies the direction of 
movement based on the encoder. This algorithm may not be available in all 
firmware versions. 
The advantage is of this approach is same as the algorithmic phasing and in 
addition it minimizes the robot motion to several encoder counts. 
The disadvantage is its accuracy is affected by the motor load, so it is not 
applicable to gravity or spring-loaded axes. 
The phasing process can be initiated at any time by pressing the Phase button. 
The controller power must be turned on. 

2 Phasing Time [ms] Phasing time is set. The voltage is applied with magnitude defined by the motor 
variable motor power for a duration defined in the motor variable phasing time. 
When Phasing Mode is Hall-Based, this item cannot be selected.  

3 Phasing Output [%] Phasing Output is set. The voltage is applied with magnitude defined by the motor 
variable motor power for a duration defined in the motor variable phasing time. 
When Phasing Mode is Hall-Based, this item cannot be selected. 

4 Phase Button Phasing is started. 
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■CN032 AC Servo Solution Firmware Manual 
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(4) Open Loop Control 

 
 

No. Item Description 
1 Voltage [%] The voltage (speed) to rotate is set. 1 to 99% can be set. If increasing this value, 

rotation of motor is fast. 
2 Reverse Button The motor rotates with Voltage (reverse). Motor reverses while the “Reverse” 

button is pushed. Motor stops when the “Reverse” button is released. 
3 Forward Button The motor rotates with Voltage (forward). Motor forwards while the “Forward” 

button is pushed. Motor stops when the “Forward” button is released. 
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4.4.3.2 Tuning Tab 
Set the position loop, speed loop, and current loop on the Tuning tab. 

 
(1) PIDVAFF Regulator/Position Loop 

 
No. Item Description 
1 KP Proportional Gain in the position control loop algorithm (0 - 32767).  
2 Vel FF Velocity Feed Forward in the position control loop algorithm (0 - 32767).  
3 KI Integral Gain in the position control loop algorithm (0 - 32767). 
4 Acc FF Acceleration Feed Forward in the position control loop algorithm (0 - 32767). 
5 KD Differential Gain in the position control loop algorithm (0 - 32767). 
6 Bias Value to be added to the output of the PID regulator continuously. 
7 Integral Limit Integral Limit in the position control loop algorithm (0 - 32767). 
8 Limit [%] Motor output limit from the position loop PID regulator (0 - 32767) 

■PID regulator of position control 

 
Figure 4-6  PID regulator 
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(2) PID Regulator/Speed Loop 

 
No. Item Description 
1 KP Proportional Gain in the velocity control loop (0 - 32767). 
2 KI Integral Gain in the velocity control loop (0 - 32767). 
3 KD Differential Gain in the velocity control loop (0 - 32767).  

 

 

(3) Field Oriented Control/Current Loop 

 
No. Item Description 
1 KP Proportional gain in the Quadrature current control loop (0 - 32767). 
2 Bipolar/Pulse Button When this button is pushed, a pulse of the specified magnitude (Output [%]) for 

the specified time (Time [ms]) is output.  
When “Bipolar” is checked, bipolar pulses (positive pulse and negative pulse) are 
output. When “Bipolar” is not checked, a unipolar pulse (positive pulse) is output. 

3 KI Integral gain in the Quadrature current control loop (0 - 32767). 
4 Output [%] Output voltage set as PWM duty cycle (32767 = 100%). Requires that the servo 

control is turned off. 
5 KD Differential Gain in the Quadrature current control loop (0 - 32767). 
6 Time [ms] Time of PWM output is set. 
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4.4.3.3 Motion Tab 

 
 

(1) Velocity Profile 
About Velocity Profile, “Trapezoidal”, “Spline-Curve”, “Bezier-Curve” and “PVT Streaming” are selected.  

 

(a) Velocity Profile：Trapezoidal and Spline-Curve 

The Trapezoidal Profile: The definition of maximum velocity, acceleration and deceleration are set. Note 
that the motion parameters are maximum values that may not be achievable given the distance to the target 
position and the abilities of the motor. 

 

The Spline-Curve Profile: Provides smooth velocity profile curve and eliminates the vibrations caused by 
the sudden start and stop of acceleration typical for the Trapezoidal velocity profile. The smooth motion 
comes at the expense of extended time to execute the same motion. 

 
No. Item Description 
1 Velocity [Enc Counts/s] Maximum velocity is set. 
2 Velocity [rpm] The value converted the maximum speed to rpm is displayed. 
3 Acceleration [EC/s/s] Maximum acceleration is set. 
4 Deceleration [EC/s/s] Maximum deceleration is set. 
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(b) Velocity Profile：Bezier-Curve 

Bezier-Curve Profile: Setting of acceleration and deceleration jerk parameters are valid. These values can 
be set in the range between 0 and 1000 and change the shape of the respective acceleration and 
deceleration profile phases. The configurable jerk allows tradeoff between the performance and the settle 
time affected by aggressive deceleration. 

The PVT Streaming Profile is intended to demonstrate the use of PVT mode which employs the host 
computer as master velocity profile generator. This approach is valuable for the synchronization of multiple 
axes and complex mechanisms. 

 
No. Item Description 
1 Velocity [Enc Counts/s] Maximum velocity is set. 
2 Velocity [rpm] The value converted the maximum speed to rpm is displayed. 
3 Acceleration [EC/s/s] Maximum acceleration is set. 
4 Deceleration [EC/s/s] Maximum deceleration is set. 
5 Acc Jerk Factor [0-1000] Acceleration Jerk (0 - 1000) is set. 
6 Dec Jerk Factor [0-1000] Deceleration Jerk (0 - 1000) is set. 

 

■References: 

< The Trapezoidal Profile >                                            < Bezier-Curve Profile > 

 

 

 

 

 

 

 

 

 

 

 

 

 

 

 

 

 

 

 

 
 



RZ/T2M Group, RZ/T2L Group, RZ/N2L Group Startup Guide (for Motion Control Utility) 

R12AN0123EJ0502  Rev.5.02  Page 37 of 61 
Aug.8, 2024  

(c) Velocity Profile：PVT Streaming 

PVT Streaming Profile (PVT= position Velocity Time): Since the communication bandwidth between the 
host and the controller is inherently limited, the velocity profiles are presented as sets of Position and 
Velocity over a fixed time slices (typically 5ms to 20ms). Hence the name Position-Velocity-Time for these 
profile time. The PVT points are streamed to each of the controllers which in turn execute interpolation 
algorithm to generate the desired position and velocity set-points each microsecond. 

 
No. Item Description 
1 Velocity [Enc Counts/s] Maximum velocity is set. 
2 Velocity [rpm] The value converted the maximum speed to rpm is displayed. 
3 Acceleration [EC/s/s] Maximum acceleration is set. 
4 Deceleration [EC/s/s] Maximum deceleration is set. 
5 Acc Jerk Factor [0-1000] Acceleration Jerk (0 - 1000) is set. 
6 Dec Jerk Factor [0-1000] Deceleration Jerk (0 - 1000) is set. 
7 PVT Time Slice [ms] PVT Time is set. 
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(2) Motion Generator 

 
No. Item Description 
1 Target #1/ Copy Button/ 

Go to #1 Button 
Position of target #1 is set. 
When pushing “Copy” button, Current position is copied. 
When pushing “Go to #1” button, the motor rotates to the Position of Target #1. 

2 Target #2/ Copy Button/ 
Go to #2 Button 

Position of target #2 is set. 
When pushing “Copy” button, Current position is copied. 
When pushing “Go to #2” button, the motor rotates to the Position of Target #2. 

3 Distance/ Reserve 
Button/ Forward Button 

Distance (Position) is set. 
When pushing “Reserve” button, the motor rotates reverse to the "Distance". 
When pushing “Forward” button, the motor rotates forward to the "Distance". 

4 Pause [ms]/ 
Cycle Move P1-P2 
Button 

When pushing “Cycle Move P1-P2” button, repeat the following. 
① The motor rotates to the Target #1. 
② Pause 
③ The motor rotates to the Target #2. 
④ Pause 
 
When pushing “Cycle Move P1-P2” button again, the motor stops. 
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4.4.3.4 Encoder Tab 

 
No. Item Description 
1 Encoder Type Encoder Type is displayed. 

When customer uses custom encoder, “Custom” is displayed. 
2 Version Encoder version is displayed. 
3 Encoder ID Encoder ID is displayed. 
4 Status(hex) Error Status of Encoder is displayed in 16-bit HEX. 
5 Status(text) Error Status of Encoder is displayed in character. 
6 update Button Error Status of encoder is updated. 
7 Bit Rate [kHz] Bit Rate[kHz] of encoder (Absolute Encoder) is selected. 
8 Read Button The value of the EEPROM address of Absolute Encoder is read. 

When pushing the “Read” button, the value of the “EEPROM Addr” is read and 
the read result is displayed in “EEPROM Data”. 

9 Write Button When pushing the “Write” button, the value of the “EEPROM Data” is written to 
address of “EEPROM Addr”. 

 

■Encoder Error Status 

Bit Indication 
0 Overspeed Error 
1 Initialization Error 
2 Counting Error 
3 Multi-turn Overflow 
4 N.C 
5 Multi-turn Error 
6 Battery Error 
7 Battery Alarm 
8 EEPROM Busy 
9 EEPROM Error 
10 N.C 
11 N.C 
12 N.C 
13 N.C 
14 N.C 
15 N.C 
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4.4.3.5 Limits tab 
The follow error detection can be set. 

・Motor position deviation 

・Overcurrent 

・Over voltage of DC bus voltage 

・Under voltage of DC bus voltage 

・Motor overload pre-detection 

・Motor position error (upper limit / lower limit) 

・Motor upper limit speed 

・Motor speed deviation 

・PVT buffer empty 

 

(1) Motor Protections/I2t Limits 

 
No. Item Description 
1 Max Position Error[ec] Max Position Error is set. 
2 Max Position Error 

Action 
When the position is greater than or equal to the Max Position Error, the action is 
set. 
0: “None”: No action. 
1: “Stop”: Servo Off 
2: “Off”: Servo Off and Power Off 

3 I2t Crnt[mA]/ Time[ms] Motor overheating current [mA] and overheating time [ms] are set. 
This protection is slow because it integrates the square of the current exceeding 
the nominal over. Once this protection is activated the output current is limited, 
but the motions is not stopped. 

4 Over Crnt[mA]/ Time[ms] The over current [mA] and the over current detection time [ms] are set. 
 

(2) Inverter Limits 

 
No. Item Description 
1 Min.Voltage [V] Under voltage of DC bus voltage is set.  
2 Max.Voltage[V] Over voltage of DC bus voltage is set. 
3 Overload pre-detect[mA] The Overload pre-detect is set.  
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(3) Position Control Limits 

 
No. Item Description 
1 Minimum Position [EC] The lower limit of position error detection is set. 

When pushing “Copy” button, position of “4.4.2 Main Screen” is copied. 
2 Maximum Position [EC] The upper limit of position error detection is set. 

When pushing “Copy” button, position of “4.4.2 Main Screen” is copied. 
 

(4) Speed Control Limits 

 
No. Item Description 
1 Max Speed [EC/s] Max speed is set. 
2 Instructed Speed Diff [EC/s] The motor speed deviation is set. 
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(5) Other 

 
No. Item Description 
1 PVT Buffer Empty Level PVT buffer empty level is set. 
2 Error Flags/ Read Button Current detected Error is displayed. When pushing “Read” button, detected Error 

is updated. 
About errors for bits, refer to” ■Error detection setting screen”. 

3 Error Mask/ Edit Button Enables / disables for each error are set. 
When pushing “Edit” button, Enables / disables for each error can be set. 

 

■Error detection setting screen 

For items checked in the check box, motor stop when error detection is activated. The item whose item name 
is bold is the item where the error is currently detected. 

 
Bit Item Bit Item 
0 N.C 16 Forward Limit Switch Triggered 
1 N.C 17 Position Error 
2 N.C 18 Abnormal Position 
3 N.C 19 Instructed speed difference 
4 N.C 20 Over Speed 
5 N.C 21 Overload pre-detect 
6 N.C 22 Ground Fault 
7 PVT Buffer Empty 23 Inverter Over Temperature 
8 Switch Setting Error 24 Motor Over Temperature 
9 Invalid Parameter Setting 25 Inverter Fault 
10 Encoder Not Detected 26 Inverter Over Current 
11 Home Procedure Error 27 Inverter Over Voltage 
12 Home Procedure Incomplete 28 Inverter Under Voltage 
13 Minimum Limit Position 29 Memory Error 
14 Reverse Limit Switch Triggered 30 CPU Voltage Drop 
15 Maximum Limit Position 31 Watch Dog Timeout 

 
  



RZ/T2M Group, RZ/T2L Group, RZ/N2L Group Startup Guide (for Motion Control Utility) 

R12AN0123EJ0502  Rev.5.02  Page 43 of 61 
Aug.8, 2024  

4.4.4 Motion Scope 
The Motion Scope can be resized and positioned independently from the main control window. The Motion 

Scope has four channels that can be configured to visualize various motion controller variables in line chart 
form. It is important to note that the data capture always takes place in the motion controller and the Motion 
Scope only visualizes the result from the data capture. This is done to allow very high rate of data acquisition 
independent from the communication bandwidth between the controller and the Windows application. 

 
 

No. Item Description 
1 Synchronization Mode Synchronization Mode is selected. 

Move Start: Waveform data is collected by triggered the start of position control. 
Move End: Waveform data is collected by triggered the stop of position control. 
Manual: Waveform data is collected asynchronously with the operation of the motion 
controller. 

2 Operation Status Operation Status is displayed. 
IDLE: Idle status. The back color of the Status Panel on the right is transparent. 
TRANSFER: Under collecting waveform data.  

The back color of the Status Panel on the right is orange. 
RECORD: Waveform data collection completed.  
The back color of the Status Panel on the right is red. 

3 RUN/STOP Button Waveform data collection is started / stopped. 
4 Single Seq when pushing "Single Seq" button, waveform data is collected once. 
5 Synch Level/Slope Level and slope (Rising edge / Falling edge) are set. Synchronization Mode: Manual is 

valid only. 
6 Sampling Rate/ Units Sampling rate is set. Minimum is 50 μs. 

“Units” is selected μs or ms. The sampling number of waveform data are 512 or less. 
Ex: When the sampling rate is set to 50 μs, the waveform for 25.6 ms (= 50 μs x 512) 
is displayed. 

7 Statistics The statistical data (maximum value / minimum value / mean value / integral value of 
absolute value of sampling data) of the selected channel are displayed. 

8 Save Image Waveform is saved in PNG format or waveform data is saved in CSV format. 
The graph can be changed scale by operating the mouse. Zoom in is clicked the corner of the graph and 
dragged to the desired range. Zoom out is clicked the edge of the scroll bar. 
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Motion scope can display waveform of 4 channels and show/hide at check box.

 
 

No. Item Description 
1 Scale Scale is set at 0.125 units. And primary axis (left side) / secondary axis (right side) of 

Y axis is set with “Left” / “Right”.  
2 Data Waveform data (variables) is selected. Refer to “5 Variables”. 
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4.4.5 Terminal 
The Terminal Emulator allows communicating the motion controllers using ASCII commands. This is helpful 

when certain command is not available as a button or when the status does not include information about 
some internal state. The commands are entered at the bottom of the screen and. The Up/Down arrow keys 
can bring the history of the recently issued commands. (Not supported on RS-422.) 

 
 

No. Item Description 
1 Suspend Polling When checking “Suspend Polling”, the acquisition of information (Position, DC 

bus voltage value, etc.) from the solution is stopped. 
2 Read the text file Button The text file that the command is written is executed. 
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5. Variables 
Table 5-1 is shown the variables that can be displayed in a graph. 

 

Table 5-1 Variables that can be displayed in a graph 
No. Variable Description 
1 Position Motor Position 
2 Velocity Velocity 
3 Acceleration Acceleration 
4 I2t Accumulator I2t Integral  
5 Pos Err Position Error 
6 PID Output PID Regulator Output Value 
7 Id Current Direct Current 
8 Iq Current Quadrature Current 
9 Id Current Err Direct Current Error 
10 Iq Current Err Quadrature Current Error 
11 ADC1 Value U Phase A/D Converter Value 
12 ADC2 Value V Phase A/D Converter Value 
13 ADC3 Value W Phase A/D Converter Value 
14 PVT Points PVT FIFO Buffer Depth 
15 D Voltage FOC Voltage Output D 
16 Q Voltage FOC Voltage Output Q 
17 RT Counter - 
18 Phase Angle Phase Angle 
19 Input Capture Current C (Input Capture Value) 
20 Position Err Position Error (pos_error detail) 
21 Pos Control Integral Position Control Integral 
22 Velocity Err Velocity Error 
23 Vel Control Integral Velocity Control Integral 
24 Id Control Integral Id Control Integral 
25 Iq Control Integral Iq Control Integral 
26 Torque Estimate Motor Torque Estimate 
27 Motor Electric Angle Motor Electric Angle 
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6. Motor Parameters 
Table 6-1 is shown the Motor Parameters of BM0602A1PD-A. 

 Table 6-1 BM0602A1PD-A Motor Parameters 
No Item Description BM0602A1PD-A 

Absolute 
1 Version N.C 0 
2 NodeId N.C 0 
3 ModuleType Module Type 

2: Electronic gearing mode is valid 
3: Electronic gearing mode is invalid 

3 

4 MotorType Motor Type 
3：PMSM/Brushless DC 
4：Induction Motor 

3 

5 EncoderType Encoder Type 
0：Incremental 
1：Endat 2.2 
2：BiSS 
3：FA-Coder 
4：A-formatTM 
5：Hiperface DSL 
6 : Custom 

3 

6 CommutationMode Communication Mode 
4: Sinusoidal vector control with encoder and Delta Sigma Modulator 
5: Sinusoidal vector control with encoder and CT 
6: Sinusoidal vector control with CT 

4 

7 PhaseCounts Electrical cycle (= the encoder counts per revolution divided by the number 
of pole pairs) 

13107 

8 EncoderCounts Encoder count for one revolution 65536 

9 PolePairs Motor pole pairs count 5 
10 HallInvert N.C 0 
11 PosInvert CW/ CCW of motor 

0: CW, 1: CCW 
0 

12 PhaseOffset N.C 0 
13 PhaseMap Windings Mapping (U/V/W placement.) 6 
14 PhaseScale N.C -5 
15 PhasingMode Phasing Mode 

0：Algorithmic 2：Dithering 
0 

16 PhasingTime Phasing Time[ms] 500 
17 PhasingPower Phasing Output[%] 20 
18 Ds Desired position loop cycle time [us] 100(=62.5us) 

19 Kp Proportional Gain in the position control loop algorithm 1648 

20 Ki Integral Gain in the position control loop algorithm 100 
21 Kd Differential Gain in the position control loop algorithm 0 
22 Il Integral Limit in the position control loop algorithm 1000 
23 Vff Velocity Feed Forward in the position control loop algorithm 0 

24 Aff Acceleration Feed Forward in the position control loop algorithm 0 

25 Bias Value to be added to the output of the PID regulator continuously. 0 

26 Iqkp Proportional gain in the Quadrature current control loop 7 

27 Iqki Integral gain in the Quadrature current control loop 40 
28 Iqkd Differential Gain in the Quadrature current control loop 0 

29 Vqkp Proportional Gain in the velocity control loop 5 

30 Vqki Integral Gain in the velocity control loop 1 
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No Item Description BM0602A1PD-A 
Absolute 

31 Vqkd Differential Gain in the velocity control loop 0 

32 MinVolt Under voltage of DC bus voltage 2600 
33 MaxVolt Over voltage of DC bus voltage 3000 
34 MinPos The lower limit of position error detection - 6553600 
35 MaxPos The upper limit of position error detection 6553600 
36 MaxVel Max speed 45776 
37 MaxVelDiff The motor speed deviation 1526 
38 MaxTemp N.C 0 
39 OvrCrnt Overload pre-detect [mA] 1000 
40 MinBuffer PVT buffer empty level 10 
41 ErrMask Error Mask 0 

42 Vcomp N.C 0 
43 MaxErr Max Position Error  16384 
44 MaxErrTime N.C 0 
45 MaxOutput Motor output limit from the position loop PID regulator 100 

46 CurrentLimit The over current [mA] 1000 
47 CurrentTime over current detection time [ms] 10 
48 I2TLimit Motor overheating current [mA] 0 

49 I2TTime Motor overheating time [ms] 0 

50 AutoBrake N.C 0 
51 ErrorInputMask N.C 0 
52 HomeFlagMask Home Mask 0 
53 AutoStopMode Max Position Error Action 

0: “None”: No action. 
1: “Stop”: Servo Off 
2: “Off”: Servo Off and Power Off 

0 

54 HallShift N.C 0 
55 ApeBaudrate Bit Rate[kHz] of encoder (Absolute Encoder) 4000 

56 GearingIn Input value of Electronic Gearing function 0 

57 GearingOut Output value of Electronic Gearing function 0 
 

 

  



RZ/T2M Group, RZ/T2L Group, RZ/N2L Group Startup Guide (for Motion Control Utility) 

R12AN0123EJ0502  Rev.5.02  Page 49 of 61 
Aug.8, 2024  

7. Appendix 
7.1 Package Folder Structure 

 
 

  

< r12an0123xxXXXX-cn032-ac-servo-solution>      *XX: Revision  *<>: Folder name 
|-- <Software> 
| |-- <Firmware>      //CN032 AC Servo Solution Firmware Folder 
| | |-- <rzn2l> 
| | |         |--Common    // Common source file for GCC and EWARM 
| | |         +--Project 
| | |                   |-- <gcc>    //GCC project for RZ/N2L 
| | |                   +- <iccarm>   //EWARM project for RZ/N2L 
| | |-- <rzn2l> 
| | |         |--Common    // Common source file for GCC and EWARM 
| | |         +--Project 
| | |                   |-- <gcc>    //GCC project for RZ/T2L 
| | |                   +- <iccarm>   //EWARM project for RZ/T2L 
| | +- <rzt2m> 
| |           |--Common    // Common source file for GCC and EWARM 
| |           +--Project 
| |                    |-- <gcc>    //GCC project for RZ/T2M 
| |                    +- <iccarm>    //EWARM project for RZ/T2M 
| +- <MotionUtility>     //CN032 Motion Control Utility Folder 
+- <Document>       //Manual, etc Folder 
  |-- <Motor>      //Motor specification Folder 
 |-- <Board>      //Controller board and Inverter board Folder 
 |-- r12um0044ejXXXX-rzt2m-rzn2l-cn032-hardware.pdf //Hardware Manual for RZ/T2M, RZ/N2L 
             |-- r12um0051ejXXXX-rzt2l-cn032-hardware.pdf  //Hardware Manual for RZ/T2L 
             |--r12um0055ecXXXX-cn032-inverter.pdf  // Hardware Manual for Inverter board 
 |-- r11um0169ejXXXX-rzt2m-cn032-firmware.pdf  //Firmware Manual 
 |-- r12an0123ejXXXX-rzt2m-cn032-startup-tuningtool.pdf //This document 
 +- r12an0124ejXXXX-rzt2m-cn032-startup-ethercat.pdf  //Startup guide for Motion Control via EtherCAT 
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7.2 How to Install Development Environments  
7.2.1 Development Environments Install 
AC Servo Solution Kit (RZ/T2M, RZ/T2L) 

Download e2studio or FSPSC for RZT FSP v1.3.0 from the following web site. 

Release v1.3.0 · renesas/rzt-fsp · GitHub 

Download “setup_rztfsp_v1_3_0_e2s_v2023_07.exe” for FSP with e2studio installer. 
If using IAR, download “setup_rztfsp_v1_3_0_rzsc_v2023_07.exe” for smart configurator installer. 

 
 

AC Servo Solution Kit (RZ/N2L) 

Download e2studio or FSPSC for RZN FSP v1.3.0 from the following web site. 

Release v1.3.0 · renesas/rzn-fsp · GitHub 

Download “setup_rznfsp_v1_3_0_e2s_v2023_07.exe” for FSP with e2studio installer. 
If using IAR, download “setup_rznfsp_v1_3_0_rzsc_v2023_07.exe” for smart configurator installer. 

 
 

If using IAR, download IAR Embedded WorkbenchⓇ for Arm Version 9.32.2 from IAR web site. 

Products | IAR Systems 

 

  

https://github.com/renesas/rzt-fsp/releases/tag/v1.3.0
https://github.com/renesas/rzn-fsp/releases/tag/v1.3.0
https://www.iar.com/products#/search?architecture=Arm
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7.2.2 Toolchain Install 
When using e2 studio, install the toolchain “GNU ARM Embedded 9.3.1” by following the steps below. 

 

(1) Select the “Add Renesas Toolchains” item from the “Help” menu.  

 
 

(2) Click “Download…” button. 

 
 

  



RZ/T2M Group, RZ/T2L Group, RZ/N2L Group Startup Guide (for Motion Control Utility) 

R12AN0123EJ0502  Rev.5.02  Page 52 of 61 
Aug.8, 2024  

(3) Open “GNU ARM Embedded” tab, select “GNU ARM Embedded 9.3.1”, and click “Finish” button. 

 
 

*If you cannot find “GNU ARM Embedded 9.3.1” in the above window, please download “9-2020-q2-update” 
from the following URL, then restart e2 studio and try again. 

https://developer.arm.com/downloads/-/gnu-rm 

 

 
  

https://developer.arm.com/downloads/-/gnu-rm
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(4) Select language and click “OK” button. 

 
(5) Click “Next” button. 
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(6) After reading click “I Agree” button. 
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(7) Click “Install” button. 

 
 

(8) Installation is complete. Click the “Finish” button. 
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7.3 Program Writing Procedure 
This chapter is shown how to write a program to serial Flash ROM. 

 

7.3.1 Power Supply 
① xSPI0 boot mode setting 

Set SW1 of the Controller board to the following. 

 
 
② Power supply to the Inverter board, and then the red lamp lights up. 

Additionally, the Controller board is supplied 5V DC power from Inverter board and then LED1 lights up. 

 
 
7.3.2 EWARM 
① Select the [All programs] > [IAR EW for Arm x.xx.x] > [IAR EW for Arm x.xx.x] from Windows start menu, 

start up the IAR Embedded Workbench. 
 

 
  

Power lamp of the Inverter board Power LED of the Controller board 
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② Select the [File] > [Open Workspace…] and select the project file below.  
AC Servo Solution Kit (RZ/T2M) 

 “Software\Firmware\rzt2m\Project\iccarm\CPU0_serialboot\ 
CN032_AC_Servo_Solution_CPU0_serialboot.eww”   

AC Servo Solution Kit (RZ/T2L) 

“Software\Firmware\rzt2l\Project\iccarm\serial_boot\CN032_AC_Servo_Solution_serialboot.eww”   

AC Servo Solution Kit (RZ/N2L) 

“Software\Firmware\rzn2l\Project\iccarm\serial_boot\CN032_AC_Servo_Solution_serialboot.eww”   

And then open the workspace. 

 
 

③ Execute build. Select [Project] > [Rebuild All]. 

 

④ Select the [Project] > [Download] > [Download active application] to write the program to serial Flash 
ROM. 

 
 



RZ/T2M Group, RZ/T2L Group, RZ/N2L Group Startup Guide (for Motion Control Utility) 

R12AN0123EJ0502  Rev.5.02  Page 58 of 61 
Aug.8, 2024  

7.3.3 e2studio 
① Import the sample project. After the program is started, by selecting [File] → [Import] → [Existing 

Projects into Workspace]. Check the "select root directory" and select the folder below. 
 

AC Servo Solution Kit (RZ/T2M) 

 “Software\Firmware\rzt2m\Project\gcc  

AC Servo Solution Kit (RZ/T2L) 

 “Software\Firmware\rzt2l\Project\gcc  

AC Servo Solution Kit (RZ/N2L) 

 “Software\Firmware\rzn2l\Project\gcc  

 

If “Copy projects into workspace" is checked, uncheck it and then selecting [Finish]. 

 

 
 

Describe the procedure for AC Servo Solution Kit (RZ/T2M) as example. AC Servo Solution Kit (RZ/T2L, 
RZ/N2L) can write the program to flash memory using the following procedure. 

  

Uncheck  
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② Build the “CN032_AC_Servo_Solution_CPU0_serialboot” project 

In [Project Explorer] view, right click the node of the project to be debugged and select [Build Project]. 

 
 

③ Press the “RESET” switch of the Controller board 

④ While the board and J-LINK are connected, start writing to the flash memory in the following order 
In [Project Explorer] view, right click the node of the CPU0 project to be debugged and select [Debug As] 
→ [Debug Configurations]. 
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⑤ [Renesas DBG Hardware Debugging] → [CN032_AC_Servo_Solution_CPU0_serialboot Debug_Flat] 
item, then press [Debug]. 

 
 

⑥ Press the terminate button to stop the debugging window 

 
 

Press the reset button of the Controller board, and then running the program written to the flash memory 
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General Precautions in the Handling of Microprocessing Unit and Microcontroller Unit 
Products 
 
The following usage notes are applicable to all Microprocessing unit and Microcontroller unit products from Renesas. For detailed usage notes on the 
products covered by this document, refer to the relevant sections of the document as well as any technical updates that have been issued for the products. 

1. Precaution against Electrostatic Discharge (ESD) 

A strong electrical field, when exposed to a CMOS device, can cause destruction of the gate oxide and ultimately degrade the device operation. Steps 

must be taken to stop the generation of static electricity as much as possible, and quickly dissipate it when it occurs. Environmental control must be 

adequate. When it is dry, a humidifier should be used. This is recommended to avoid using insulators that can easily build up static electricity. 

Semiconductor devices must be stored and transported in an anti-static container, static shielding bag or conductive material. All test and 

measurement tools including work benches and floors must be grounded. The operator must also be grounded using a wrist strap. Semiconductor 

devices must not be touched with bare hands. Similar precautions must be taken for printed circuit boards with mounted semiconductor devices. 
2. Processing at power-on 

The state of the product is undefined at the time when power is supplied. The states of internal circuits in the LSI are indeterminate and the states of 

register settings and pins are undefined at the time when power is supplied. In a finished product where the reset signal is applied to the external reset 

pin, the states of pins are not guaranteed from the time when power is supplied until the reset process is completed. In a similar way, the states of pins 

in a product that is reset by an on-chip power-on reset function are not guaranteed from the time when power is supplied until the power reaches the 

level at which resetting is specified. 
3. Input of signal during power-off state 

Do not input signals or an I/O pull-up power supply while the device is powered off. The current injection that results from input of such a signal or I/O 

pull-up power supply may cause malfunction and the abnormal current that passes in the device at this time may cause degradation of internal 

elements. Follow the guideline for input signal during power-off state as described in your product documentation. 
4. Handling of unused pins 

Handle unused pins in accordance with the directions given under handling of unused pins in the manual. The input pins of CMOS products are 

generally in the high-impedance state. In operation with an unused pin in the open-circuit state, extra electromagnetic noise is induced in the vicinity of 

the LSI, an associated shoot-through current flows internally, and malfunctions occur due to the false recognition of the pin state as an input signal 

become possible. 
5. Clock signals 

After applying a reset, only release the reset line after the operating clock signal becomes stable. When switching the clock signal during program 

execution, wait until the target clock signal is stabilized. When the clock signal is generated with an external resonator or from an external oscillator 

during a reset, ensure that the reset line is only released after full stabilization of the clock signal. Additionally, when switching to a clock signal 

produced with an external resonator or by an external oscillator while program execution is in progress, wait until the target clock signal is stable. 
6. Voltage application waveform at input pin 

Waveform distortion due to input noise or a reflected wave may cause malfunction. If the input of the CMOS device stays in the area between VIL 

(Max.) and VIH (Min.) due to noise, for example, the device may malfunction. Take care to prevent chattering noise from entering the device when the 

input level is fixed, and also in the transition period when the input level passes through the area between VIL (Max.) and VIH (Min.). 
7. Prohibition of access to reserved addresses 

Access to reserved addresses is prohibited. The reserved addresses are provided for possible future expansion of functions. Do not access these 

addresses as the correct operation of the LSI is not guaranteed. 
8. Differences between products 

Before changing from one product to another, for example to a product with a different part number, confirm that the change will not lead to problems. 

The characteristics of a microprocessing unit or microcontroller unit products in the same group but having a different part number might differ in terms 

of internal memory capacity, layout pattern, and other factors, which can affect the ranges of electrical characteristics, such as characteristic values, 

operating margins, immunity to noise, and amount of radiated noise. When changing to a product with a different part number, implement a system-

evaluation test for the given product. 
 
 

○Arm and Cortex are registered trademarks of Arm Limited (or its subsidiaries) in the EU and other 
countries. All rights reserved. 

○Ethernet is a registered trademark of Fuji Xerox Co., Ltd. 
○IEEE is a registered trademark of the Institute of Electrical and Electronics Engineers Inc  
○EtherCAT® is registered trademark and patented technology, licensed by Beckhoff Automation GmbH, 

Germany.  
○A-format is a trademark of the Nikon Corporation. 
○Additionally all product names and service names in this document are a trademark or a registered 

trademark which belongs to the  
   respective owners. 
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